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Introduction

Teleprompt+ is a simple, yet powerful professional teleprompter application for the 
Macintosh, iPad, iPhone and iPod touch. Whether you are a video producer looking for 
an affordable, portable alternative to traditional teleprompter setups, or a public speaker 
looking for a powerful aid for delivering speeches, our goal is to provide you with the 
easiest to use and yet most effective prompting solution available on the iOS and 
Macintosh platforms.

In addition to basic text prompting functions, Teleprompt+ offers many advanced options 
and features that will enable you to custom tailor your prompting setup according to 
your own needs. We offer such advanced features as text mirroring (for true hardware 
mirror setups), dual screen prompting and wireless remote control capability.

Despite these advanced features, it is incredibly simple to get up and running with 
Teleprompt+. We’ve strived to keep Teleprompt+ as simple to use as possible, and we 
believe we’ve succeeded. Within minutes of purchase, you can be prompting with little 
setup or knowledge of the product. To get started quickly, we suggest you review the 
Getting Started section of this guide, and then dig deeper into the advanced features to 
find the options that meet your needs.

We are constantly looking to improve our product. If Teleprompt+ is not meeting your 
needs in some way, or if you have suggestions for improvement, please contact us at 
support@bombingbrain.com. Enjoy!

Gene Whitaker
CEO, Bombing Brain Interactive
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Getting Started
The text that you read in Teleprompt+ is referred to as a script. Prompting with 
Teleprompt+ can be as simple as following 5 basic steps:

1) Launch the app by double clicking the app icon in the applications folder or single 
click the icon in your dock.

 

2) Click the  button to add a new script (or type ⌘N). This button is located in the 
lower left hand corner of the list of scripts. 

3) The Script name field will automatically be selected. Type a name for your script.
4) Click the content field, and either type in your script, copy/paste your script from 

another app such as Mail or Pages.
5) Click the Start Button.

Thats it! A countdown will appear, followed by the prompting screen (also referred to as 
prompting mode in this guide), where your text will begin scrolling from bottom to top 
of the screen using several default appearance and behavior settings that are built into 
Teleprompt+.

Modes
Teleprompt+ uses two main views or modes. The vast majority of setup and prompting 
is done using these two views:

Editing Mode Prompting Mode
This is the view that appears when you 
launch Teleprompt+. Use this mode to 
enter your script and configure the 
appearance and playback settings for 
each individual script.

This is the prompting or playback view, 
where Teleprompt+ actually renders your 
script and scrolls the text for you to read 
in real time.
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Editing Mode Prompting Mode

Editing Mode
When you launch Teleprompt+, the app will be in Editing Mode. This mode is used for 
script editing, and also for configuring how the script will behave when prompting 
(settings). When the app starts up, it will always load up the text and settings for the 
most recent script that you were working with. If this is the first time you are using 
Teleprompt+, the app will present you with a blank form to enter your first script.

The editing mode consists of three main areas:

• Script List - the list of scripts stored in Teleprompt+
• Editor - Script entry and modification
• Configuration - custom playback, appearance settings, and cue points
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Script List
The script list is a list of all the scripts that you 
have created and stored using Teleprompt+. You 
can hide and display the script list in various ways. 
Click the Scripts button in the tool bar along the 
bottom of the window, select Hide/Show Scripts in 
the View menu or simultaneously press Command-
Option S.

Selecting a script
To access a script, simply click on the script’s name in the script list. The content and 
settings for that script will populate the editor.
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Creating a script

To create a script, click the  button in the bottom left of the script list panel. Another 
way of creating a new script is to use the New menu option in the File Menu or simply 
press Command-N. When a new script is created the editor will display an empty form 
for you to enter your script name and content.

Deleting a script

To delete a script, select a script in the script list and click the  button at the lower 
left hand side, or press the delete key. You will be asked to confirm the delete. Click Yes 
and your script will be deleted.

 Note: This action cannot be undone.

Importing scripts
To import one or more scripts from the Dropbox or Google Docs online services, click 

the  button at the lower left hand side of the script list (or use the Import 
option in the File Menu). See the “Importing Text” section below for more information on 
importing documents.
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Editor
The editor is where you input your 
script and edit it as needed. The 
editor contains all functions for 
editing and structuring your script. 
Text can be imported into the editor 
using a variety of methods. The 
editor is also used to position and 
manage cue points within your script. 
Cue points will be described below.

Expanding the editor
Teleprompt+ was designed to help 
make script editing simple. 
The text fields within the editor can 
be expanded for more viewing area 
by clicking the Scripts button in the 
bottom toolbar and turning off the cue points or settings panel with the buttons on the 
right side of the toolbar. This will increase the size of the text fields for easy reading and 
editing. To see the cue points or settings panels again just click the buttons in the 
toolbar.

Editor Menus and Keyboard Shortcuts
Appearance Settings

The script editor’s appearance can 
be customized to suit your needs. 
Most of these preferences can be 
accessed via the application menu 
and keyboard short cuts.

By accessing the View menu and 
navigating to the Script Editor sub-
menu you can change the 
appearance of the script editor. 
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Note - these preferences have no effect on the appearance of text while in prompting 
mode (see the section on “Settings” below for information on changing the appearance 
of text while prompting).

Increase/Decrease Font Size (⌘+ and ⌘-): Use these menu options change the size 
of the font in the script editor area.

Font: This sub-menu will give you a choice of 5 pre-selected fonts for use with the script 
editor.

Shortcuts

The editor also provides keyboard shortcuts for easy navigation between scripts.

Previous/Next Script (⌘→ and ⌘←): To quickly switch between scripts, choose these 
menu options or use the keyboard shortcuts. This works well when you have the script 
list hidden but need to switch between scripts.
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Importing Text
The simplest method of text entry is direct editing. Simply click the name and content 
fields in the editor area and enter or modify your text using the on-screen keyboard.

In addition to direct text editing, you can also copy and paste your script text from any 
other Mac application.

Copy/Paste From Another App

This example demonstrates copy/paste from the Safari app, but the same method can 
be used to copy text from any other application that supports text. 

Note: like most teleprompters, Teleprompt+ is a text-only application. Special formatting 
such as bold/italic will not translate to Teleprompt+. The text will copy, but you will lose 
any formatting.

1. First, select and copy text from any application as normal.

2. Next create a new script in Teleprompt+ and (see Creating a script above). Click in 
the content area and either press Command-V or click the the Edit menu and select 
Paste. Your script text will now appear in Teleprompt+.
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File Menu

As with most other Macintosh apps, Teleprompt+ 
has a File menu with some of the standard options 
such as Open....  When clicking on this option it 
opens the standard file dialog. Just the find the text 
file you want to import, select it and click the Open 
button. 

Note: The open window will only allow you to import files that have the .txt extension. 
Please make sure any files that end with that extension are true plain text files.

Drag & Drop

Teleprompt+ also supports dragging and dropping of files directly into the app.  To 
import a script with drag & drop, make sure your file is a plain text file and has the .txt 
extension. Drag the file to the Script List area and drop the file. Your script will then 
appear in the list and will be stored within the app. You can also drag & drop multiple 
files for quick imports.

Importing From Google Docs and Dropbox

Teleprompt+ integrates with both the Google Docs and Dropbox services to provide 
simple import of scripts that have been written and saved to your online Google 
Documents or Dropbox accounts. 

Note: Teleprompt+ can only import text files. If you are using a rich editor such as 
Microsoft Word, please save your document as text (.txt) before attempting to import it 
into Teleprompt+.

To import from Google or Dropbox, follow these simple steps.

1. Click the “Import...” button in the bottom left of the script list or choose the “Import...” 
option from the File menu.

2. The import window will display. Click on the option for Google Docs or Dropbox from 
the list on the left. 
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3. The first time you use either of these services, they will request that you login and 
give approval for Teleprompt+ to access your account.  If you’ve already logged in 
using Safari then it will automatically log you in and ask for approval.  

4. After a successful login and approval, a list will appear showing the folders and text 
documents available on your account. Click one or more files to import.

5. To select multiple files hold down the Command key (⌘) and click all documents you 
would like to import.

6. When all files have been selected, click the Import button that is located at the bottom 
right of the import window.

Switching Google Docs/Dropbox accounts

If you’ve already logged in to a Google Doc or Dropbox account and 
need to switch to a different account, simply open the import window 
(⌘I), click on the service you want to log out of, and click the logout 
button that is located at the bottom left of the window.
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Syncing changes between Google Docs and Dropbox

Teleprompt+ also has the capability to save any changes you make in the script editor 
back to your online accounts, as well as download any updates to the script that have 
been made outside of Teleprompt+. This allows great flexibility in collaborating with a 
team to get changes to a script quickly and easily.

In the script list window any script that has been imported from Google Docs or Dropbox 
will display an icon of the service to the right of the script name.

To send changes to or from either Google Docs or Dropbox simply click the icon. 
Teleprompt+ will then determine if it needs to send changes to the service, retrieve an 
update from the service, or ask which version to keep if the script has changed.
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Cue Points
Teleprompt+ supports cue points for fast cueing inside a script. Cue points allow you 
to mark key points in the script so that you can jump quickly to those points during 
prompting.

To add cue points to your script, position the cursor in the text editor where you would 
like to put the cue point and right-click (control-click). A context menu will appear. Click 
Add Cue Point.

Teleprompt+ will insert a small symbol (➠) in your script to mark the position of the cue 
point. 

To review all of the cue points you have set within a script, click the Cue Points button at 
the bottom right of the toolbar.  

A menu will appear showing a list of all of your cue points.  Click on a cue point to 
advance the text editor to that position. 

When the cue points panel is visible, you can 
also add cue points with a click of the button 
that is at the top of the cue points panel. Just 
place your cursor in the script where you want 
the place the mark and click the “Add new Cue 
point” button.

To remove a cue point, simply place you cursor 
after the cue point marker in the text editor, and hit the delete key on the keyboard.
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To see cue points in action, click the start button to begin prompting. Your script will 
begin to scroll. To quickly jump to one of your predefined cue points while prompting, 
click the forward or reverse cue point buttons just below the pause button on the 
console.

Clicking these buttons will advance the prompter to the position of the next or previous 
cue point. Teleprompt+ remembers the position of your cue points, but does not display 
their markers while in prompting mode, to reduce distraction to the reader.
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Settings
The settings view appears to the right of the editor and shows nearly all of the behavior 
and appearance settings for your script when in prompting mode. One nice feature of 
Teleprompt+ is that these settings are customized and saved per script, so you can 
have different settings for each script.

To display the settings panel just click on the Settings button in the bottom toolbar.

Preview Area
At the very top of the settings panel is the 
preview area. This area provides a preview of 
what the script will look like when prompting 
with the current settings applied.

Behavior Settings
Just below the preview window are the 
playback behavior settings. These settings 
determine how Teleprompt+ will present 
and scroll your script. Click on each setting 
to make a change.
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Speed
Use the Speed setting to adjust the 
starting speed of the script. Either click 
and drag the slider for large changes or 
click the arrows on either side of the 
button to make small adjustments.

Countdown
The Countdown setting sets a countdown 
that runs before your script begins. You 
can disable the countdown entirely by 
setting it to 0, or choose the length of the 
countdown (in seconds).

Timers
View Timers allows you to show or hide 
the timers that appear at the top of the 
screen during prompting.

Text Mirroring
Turn the Mirror Text setting on if you are 
mounting your Mac or external display in 
a true teleprompter reflector setup. 
Teleprompt+ will invert the text while 
prompting, so that text will appear 
correctly on the teleprompter mirror.

Reading Guides
The Guide setting is used to configure 
reading guides. Reading guides appear 
as an arrow or highlighted area of the text 
on screen during prompting. Their 
purpose is to help the reader focus. 
Teleprompt+ offers arrow and shaded 
area guides, and these options can be 
combined.

Use the Guide Size option to adjust the 
size of the guide area.
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Appearance Settings
The bottom group of settings 
configure the text's appearance when 
prompting. 

Text Color and Background
The Text Color and Background settings 
allow you to choose the colors that 
appear when prompting. 

Font
The Font setting will show you a visual 
preview of the text as it will appear during 
prompting. Use the controls to change the 
font and adjust size to your preference.

Setting Defaults

Teleprompt+ makes it extremely easy to save your favorite custom settings as default 
for easy application to other scripts. To configure your default settings, simply click the 
Save as Default button  once you have chosen your preferred settings in 
any script.

To apply these settings to any other script, open the script by clicking on its name in the 
Script List and then click the Use Default button .
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Prompting Mode
Once you have a script created in Teleprompt+ and have configured the settings, click 
the Start button to begin prompting (or press Command-Option R). This will launch 
Teleprompt+ into Prompting Mode.

Timers
At the top of the screen are timers that can help you properly time your speech or 
session. Teleprompt+ calculates an estimated speaking time based on the length of 
your script, and the playback speed selected. Running timers will show elapsed time, 
actual prompting time and time remaining based on the estimate. The timer bar can be 
turned off if you prefer (see View Timers above).

Text Area
Your script will appear in the center of the prompting view and scroll automatically.
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Keyboard Shortcuts
Teleprompt+ has a set of keyboard shortcuts that allow for quick adjustments during the 
the prompting session. Use the following keystrokes to control prompting behavior:

Play/Pause: Space Bar
Slow Down: <
Speed Up: >
Previous Cue Point:  [
Next Cue Point:  ]
Exit Script: ESC or X
Restart/Begin Script: B
Decrease Font Size: -
Increase Font Size: +
Up Arrow: Speed Up
Down Arrow: Slow Down

Gestures and Mouse Scrolling
Teleprompt+ recognizes hand gestures made directly on a trackpad:

• Single Click: Click once with one finger to reveal the Console (see below)

• Two-Finger Swipe Up and Down: To scroll the text forward or backward live while 
prompting, simply place a two fingers on the trackpad and swipe up or down to the 
position the text where you desire. If you do not have a trackpad then using a scroll 
wheel on your mouse will have the same affect.

• Two-Finger, Double Tap: You can pause and resume playback by tapping twice 
quickly (double-tapping - NOT clicking) anywhere on the text area using two fingers.

• Three-Finger Swipe Left And Right: Placing 3 fingers on the trackpad and swiping 
left will jump your script to the previous cue point. Swiping right with 3 fingers will 
advance your script to the next cue point

• Pinch & Zoom: Using the standard pinch and zoom gesture will slow down and 
speed up the script respectively. 
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Guides
Optional reading guides appear as either an arrow, highlighted area, or both in the text 
area if you enable them in your settings (see Reading Guides in the Settings section of 
this guide). The purpose of a reading guide is to highlight a focus area where the reader 
should concentrate his or her attention while reading. Here we have enabled both an 
arrow and highlighting guides. As you can see the reading area is identified by an arrow 
and highlighted area.
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Console
Click the screen once to reveal the console. The console appears at the bottom of the 
screen. It will auto-hide after about 5 seconds. Click the lock button to lock the console 
in place if you do not want it to auto-hide. The console contains the following controls 
that will allow you to tweak the playback of your script in real time. 

Playback Controls
Playback can be controlled by clicking the pause/play button to stop and resume 
scrolling. Your chosen speed is displayed to the right of the pause/play button. To 
quickly increase or decrease speed, click the slower or faster button. If you require 
more precise speed control, the speed slider can be used to make very fine speed or 
large adjustments.

The buttons just below the play/pause button are cue point buttons. These buttons will 
advance or reverse the text to specific points that you have predefined in your script. 
For more information about placing cue points in your script, please see Cue Points in 
the Editor section of this guide.

On the left side of Play/Pause button are buttons to quickly adjust the font size that is 
currently being displayed. 

On the far left side of the console are the audio and video recording buttons. Clicking 
the audio button will start recording audio. Clicking the video button will display the 
video preview window from which you can start recording video. Please see the Audio & 
Video section below for more details.

Teleprompt+ for Mac User Manual Version 1.2

Copyright ©2011 Bombing Brain Interactive. All rights reserved.! 24

Lock Pause/Play Speed

Advance Cue PointReverse Cue Point

Font SizeAudio

Video



Reset and Exit
When you reveal the console, two additional controls appear toward the top of the 
screen. On the left, a reset button allows you to restart your script from the beginning. 
On the right, the exit button is used to exit prompting mode.
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Advanced Features

Preferences
There are several application preferences that control the way Teleprompt+ appears 
and behaves. To access the application preferences click the Teleprompt+ menu in the 
application menu and choose Preferences... (Command+, for the shortcut).
   
There are 3 preference sections: Script Editing, Prompting and Recording which pertain 
to different areas of the application. Simply click on an option at the top to view and 
configure the application to your liking.
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Script Editing Preferences
The script editor is the main section of the app where you can create, modify and add 
cue points to your scripts. We have provided a small set of font choices that you can 
use to configure the appearance of the text in the editor. Click on a font to change the 
editor font. Click the font size up and down buttons to find the font size that works best 
for you.
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Prompting Preferences
Teleprompt+ defaults to prompting in full screen mode, but if you would rather it display 
in a resizable window simply click the In Window option within the Preferences screen.  
This is useful if you have other windows you would like to see while prompting or for 
aligning the teleprompt view in-line with your camera. 

Dual Screen Mode Preferences
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Dual Screen mode preferences are only enabled when a secondary monitor is detected. 
Here you can enable or disable dual screen mode and set how text is displayed on both 
monitors while prompting. Please refer to the section on Dual Screen Mode later in this 
document for more information.

Note: All of these settings can also be quickly changed through the View ➜Script Editor 
and Dual Mode menus.

Recording Preferences
Teleprompt+ has the ability to use any digital video camera attached to your computer to 
record the presenter while prompting. Through the recording preferences you can set 
the video quality of the recording. There are 3 options from which to choose: high (HD 
1280 x 720), medium (640 x 480) and low (320 x 240). From the recording preferences 
window you can set which quality you would like. 
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Text Mirroring
Teleprompt+ supports text mirroring for split-glass reflector hardware that is commonly 
used in film and broadcasting. If you have turned on the Mirror Text setting for a 
particular script, the text area in prompting mode will invert the script text and the 
reading guides on screen. When the Mac or an external screen is placed in the camera 
reflector, the text will appear correctly to the reader.
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Dual Mode (Multi-Monitor Setups)
By connecting an external display or second monitor, you can use Teleprompt+ in Dual 
Mode. While prompting, the text will appear and scroll on both screens. The controls will 
appear only on the screen that you have designated as the main screen (control 
screen). The secondary screen (talent screen) is for display purposes only and there is 
no console visible. The main window will work as normal with all the standard controls 
and gestures available and can be used to remotely control the other monitor. This is 
ideal for professional prompting setups where there is a reader and a separate 
teleprompter operator.

There are 3 ways to enable dual mode:

1) Go to the preferences window and check Enabled under Dual Screen Mode.
2) Use the Dual Mode menu, which only appears when a secondary screen is detected, 

and select Enabled.
3) Press the keyboard shortcut Command-D to turn dual mode on and off.

When in dual mode the secondary screen will display a standby screen when not in 
prompting mode to let the talent know the operator is busy.
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External Display Text Mirroring in Dual Mode
Teleprompt+ also has a unique feature when using an external display and text 
mirroring combined. You have the option of mirroring the talent screen only or both 
displays. 

• Mirror Both Screens - In this mode the text will be inverted on both the monitors. 
Use this mode if you intend to use two reflectors for both sides, left and right, of the 
talent. This mode is excellent for dual reflector setups where the reader has a choice 
of which reflector to read.

• External Screen Only - In this mode, Teleprompt+ will only invert the text on the 
secondary (talent) monitor, while keeping the text on the main screen in a normal 
orientation. This is perfect for integrating Teleprompt+ with traditional split-glass 
setups where a monitor is placed in the reflector. In this configuration both reader 
and the controller will see the text correctly.
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Wireless Remote Control
Teleprompt+ has the capability to be remotely controlled, as well as control another 
device, using the following wireless devices:

• iPhone, iPod touch, or an iPad - An iOS device that has 802.11 wireless 
networking support can be used to remotely control Teleprompt+.

• Macintosh - A desktop or laptop computer running Teleprompt+ for Mac can also be 
used to remotely control another desktop running Teleprompt+ over a local 802.11 
wireless network.

When using an iOS device, you must run one of the following apps on the device:

Teleprompt+ for iPad or Teleprompt+ for iPhone (full paid version)

Teleprompt+ Remote (free iPhone app)

Version Compatibility
New versions of Teleprompt+ are normally not compatible with older versions of 
Teleprompt+ for remote control purposes. This is because we often rework remote 
control functionality in our updates. In order for the remote to work, both the prompting 
device and the remote control have to communicate in the same language. For this 
reason it is imperative to have the latest versions of the apps on both devices.

For the greatest reliability, please ensure that you are running the most recent version of 
Teleprompt+ on all devices. We recommend always keeping your app versions current. 
To do this, run the App Store app on all devices and computers and click the “Updates” 
button at the bottom of the screen. If Teleprompt+ or Teleprompt+ Remote appears in 
the list of updated apps, click Install to download and install the update. If Teleprompt+ 
does not appear in this list on either device, your apps should be up to date and 
compatible.

Wireless Network Setup
Once you have Teleprompt+ for Mac installed on a machine, and either Teleprompt+ or 
Teleprompt+ Remote installed on the remote control device, first ensure that WiFi is 
enabled on both devices:

1. Make sure both the Mac and the remote controlling device are on the same WiFi 
network. Please refer to the user guide for iOS for instructions on how to enable 
WiFi on those devices.
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Remote Control Setup
Once you have enabled wireless networking on your devices, you are now ready to 
setup Teleprompt+ for remote control. 

1. Launch Teleprompt+ on your computer.

2. Launch the remote software on the remote device:

‣ If you are running the full version of Teleprompt+ on the remote device, launch 
the app and then click the Remote button at the top left in Editing Mode to 
access the device list.

‣ If you are using Teleprompt+ Remote, simply launch the app.

‣ If you are using Teleprompt+ for Mac, click the button labeled Remote in the 
lower left hand side of the toolbar.

3. Choose your network connection. Teleprompt+ will prompt you and ask which type of 
connection you prefer to use. To control the teleprompter running on a desktop you 
will always have to choose Online which corresponds to WiFi. 

Note: bluetooth communication is not available for the Mac version at this time. 

Note: If you use Teleprompt+ for Mac to control another Mac it will not display this 
prompt.
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4. Choose a device to control. The Device 
List will appear. If your devices are able 
to pair, or the devices are set up on the 
same wireless network correctly, you 
should see the name of the prompting 
device in this list. Click the device name 
to initiate a remote control request.

5. On the prompting device, you will be prompted with a remote control request. Click 
Yes to allow remote control.

6. If the prompter is not already in 
prompting mode you will 
automatically be shown the list of 
scripts on the prompting device. 
Otherwise if you need to switch 
the currently running script from 
the remote just click the Remote 
Scripts button at the top of the 
screen. A list of scripts on the 
prompting device will appear. 
Click the name of the script that 
you want to control. The 
prompting device will begin to run 
the script using the settings that 
are defined on that device. You 
are now remotely controlling the script.

Live Remote Control
Text Preview

Once a connection is established and prompting is initiated, Teleprompt+ has the ability 
to preview the text on the remote device during prompting. The app makes every effort 
to keep the text in sync between the devices. This allows two-person prompting 
sessions where the controller does not need to be able to see the prompting screen that 
the reader is viewing. During prompting in a remote control session, the prompter and 
the remote will exhibit the following appearance behaviors:
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Prompter - On the prompting device, the text will appear and behave as specified in the 
script’s settings. Use the remote to modify some of these settings live during prompting.

Remote - On the remote device, 
Teleprompt+ will also display the text 
from the script and scroll it at the 
speed that is configured in the scripts 
settings. The text will appear on the 
remote with the same font and colors 
as on the prompting device. The size 
of the text will depend on your remote 
setup. The remote will always try to 
mimic the exact appearance of the 
prompting device. This is to ensure 
that the text alignment and spacing is 
consistent and synchronized on both 
devices. The remote may scale its 
view if the size of the displays do not 
match, for example:

‣ If the remote’s screen and the 
prompting screen are the same size (such as Mac-to-Mac, same display 
resolutions), the text should appear pretty much identical, because there is no need 
to scale.

‣ If the remote’s screen is different from the prompter (Mac-to-iPad, or different iOS 
device rotation), the remote will scale its text view to match the prompting device’s 
view size. This may have the effect of making the text appear stretched or squished 
on the remote screen. However, the text should stay in sync with what is currently on 
the prompter. (Without this scaling, the text size would not fit on the remote screen, 
and the text preview on the remote would quickly fall out of sync with the prompting 
device.) 

Controlling Playback Behavior

During a remote prompting session the following settings can be altered in real time.

Scroll Position - To scroll the text forward or backward, use either the scroll bar, a 
scroll wheel on your mouse or a two finger swipe up or down on a trackpad. The 
prompter will advance or reverse its position in sync.
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Use the console on the remote to control the following:

Pause/Play - Click the pause/play button on the remote to stop and start playback.

Speed - Click the speed up/down buttons to control scrolling speed.

Cue Points - Click the advance or reverse cue point buttons to cue the script to pre-
defined cue points in the script.

Font Size - Use the font size buttons to change the text size on both devices in real 
time.

Reset and Exit - Click the Reset button at the top left of the remote screen to restart the 
script on both devices. Click Exit to stop the script and exit remote control.
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Audio and Video Recording
Teleprompt+ can capture audio through any standard audio capture device such as the 
built in microphone or any 3rd party microphone that is attached and configured on your 
Mac. Video can also be captured on computers that have a camera such as a built-in 
FaceTime camera or standard digital video camera.

Audio Recording
If your computer has a microphone, while prompting you will see a 
record button in the console. Tap this button to record an audio take. 
When audio is being recorded the record button will have a yellow glow. 
You can stop and start recording as many times as you like, as long as 
your computer has space for the audio files. 

Audio files are stored on your computer at : <User Name>/Music/Teleprompt+/ 
 
They also can be reviewed through the app in the recordings panel, explained below 
(see Browsing and Reviewing Recordings).
 
Video Recording
If your Mac is equipped with a video camera such as a built-in FaceTime camera or 
other digital video camera then you can capture video directly into Teleprompt+. The 
app uses the current default camera that is set up for your computer.  

Teleprompt+ allows 3 different video recording modes: high (HD 1280 x 720), medium 
(640 x 480) and low (320 x 240) quality.  The quality can be set in the preferences 
window of the app, which is explained in the Preferences section above. Note: high-
quality recordings can consume a large amount of space on your computer for only a 
few minutes of video, so please ensure you have adequate disk space.

Video files are stored on your computer at : <Your User Name>/Movies/Teleprompt+/ 
 
Videos also can be reviewed and/or deleted through the app in the recordings panel, 
explained below (see Browsing and Reviewing Recordings).

While prompting, the Video button will appear like a camera on the 
console. click the video button to open the video recording preview 
window. This window can be moved to any position on the screen and 
resized by clicking and dragging the lower right corner. Place the preview 
window outside of the area from which you will be reading for best 
results.
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To begin recording, click the Video Record button. The button will glow bright red. To 
stop, click the button again. Multiple takes can be recorded by stopping and starting 
recording.

All videos recorded with Teleprompt+ are compressed with standard H.264 video 
compression and can be easily imported into most video editing packages for further 
refinement and publishing.

Browsing and Reviewing Recordings
To review your recordings (both audio and video), exit prompting mode and return to 
editing mode. On the bottom right side of the toolbar is a Recordings button. Click this 
button to review a list of your recordings. 

                       

In this view you can play back your recordings. Click the play button next to each 
recording in the list to play back the recording.
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To remove a take, simply click the trash can to the right of the take. Please note that 
deleting a recording is permanent and cannot be undone.

You can also right click on each take and choose Play or Delete from the pop up menu.

Locating the Recording Files

Audio recordings are stored in your user account Music folder which is found at <User 
Name>/Music/Teleprompt+. 

Video recordings can be found in your Movies folder under <User Name>/Movies/
Teleprompt+.

A quick of way of finding your recordings is to 
control-click (or right-click) on the take in the 
recordings panel and choose Show in Finder. This 
will open a Finder window to the location of the file 
and automatically select the file. 

Note: Moving or deleting recordings from these folders will also cause the recording to 
be removed from Teleprompt+ the next time it runs or the script is updated.
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